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Software Introduction

Cube-link is a free version of the software Cube-manager. It offers tools for the transferring
and processing of data from GNSS receivers and total stations.

The application has a modern Microsoft interface and implements a CAD, easy to use and
flexible, which allows you to view data in both 2D and 3D. It offers functions for graphical
and tabular displaying of raw data and results; some COGO commands; functions for
importing and exporting data, using standard file formats such as DXF or CSV and manages
the most common vector entities (lines, polylines, circles, arcs, texts, etc).

The Cube-link also supports a special point entity called the Topographic Point.
Topographic points are the fundamental parts of each survey and are generated by
importing data or using specific tools. These must be considered as a data structure that
contains all the information acquired during the topographic survey, even if obtained from
multiple surveys of the GNSS or TPS type. For example: importing a GNSS survey generates
topographic points that will be represented by symbols and with different graphic
properties. These must be considered as a data structure that contains all the information
acquired during the topographic survey, both relative to the position, such as coordinates
(east, north, height, latitude, longitude, elevation) but also related to accuracy and control
(e.g. Residuals), and information on working methods (e.g. RTK differential correction).
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STONEX

Copyright © 2017-2020

All rights reserved

Version 4.3.20200114

© cube-link

& STONEX

| 312 N -XG)]

Cube-link - [Untitled]

130

o1

[x[+]

A
I command: | |
=

& Pan %, Select

® & | &30 Views «

Home CAD Measures Topography Lines/Constraints 3D Models Raster Post-processing
= ‘e N - = -7 — o | . ErD
(= E; £ ) ke =R @ Qy ' onpoint [_|:| [ | €& O Fom entties =
Import Import Import Import Create Print DxfDwg Dxf/Dwg | Limits Window f=y Magnifier | Copy Paste | Manage @ Move on current Language
Cube-a RWS GeoGIS ASCIL map In out Q zoom.. - O Modif.. - B
In/ Out Zoom Clipboard Layer DB Language
Project 2o %o~ % ? 4= Maver DEFALLT - Mfromlayer  + fromlayer ——— - fromlayer: 0.10 -+ ¢ L0 (3 e (D 0D o A
e
w| R r AT - —
L] Scale 15650 EFoiook (0BF Lo & i+ P m TN EQay
® 3D Vie © 2D View

W
X
/"/
@j
—q !
(5]
-
v
]
@
L'l
L

| Meters | x = 5024.143; ¥ = 10153.792 ; 7 = 0.000 | Elev. 0.00 | ortho

| Polar

Thickness

1] Reference arid |:= Tools bar ~

Stonex Cube-link v4.3 — User manual 5



©

STONEX

1 Installing and uninstalling Cube-link

1.1 Cube-link installation
To install Cube-link just start the installer, select the language (which can be changed at any
time even with the installed program), read and accept the user license agreement, select
the folder for the location of the shortcuts and choose whether to create a shortcut to the
program from the desktop. Before clicking the Install button, you can check and possibly
change the location of the program folder, the start menu folder and any additional tasks,
such as the creation of a desktop shortcut.

The setup is available for 32-bit and 64-bit platforms.

1.2 Cube-link uninstallation

To uninstall, go to the folder where the program is located and press the uninstall button
that will execute the operation.

Stonex Cube-link v4.3 - User manual 6
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2 General functions

2.1 File (tab)

File is the first tab and is located at the top left of the main screen. This section contains
many utility commands, including one for settings, and for import and export operations
(Figure 2.1). The commands at the bottom provide general information: by clicking the
Release notes command, you can access the file with a summary of all the information
concerning the new versions and the updates of the program; Online Manual is the
command that opens the PDF of the User Manual; Information opens the general
presentation window of the software, where you can see the installed version number and
the active module or modules.

lﬂ' Mew...

rb Open...

E.ﬁ' Save

Save as...

Save copy as...

Recent projects 4
Impaort v
Export 4
Settings...

Yoo gdP P

Upload utility files ’

Fieldbook list...

Check for updates...

(W I

Activate Cube-
manager...

W% Releasenotes @ Onlinemanual @ Information X Close window (Exit)

Figure 2.1
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2.1.1 Create, open and save jobs

Cube-link files have .cubelnk extension and contain all the CAD and topographic entities
used during processing. When you want to create a new job, the application asks if you want
to create a new blank job with default variables or if you want to proceed with a new job
with variables from template files, it is in fact possible to save template files ( with extension
.cubetpl) that contain all the settings used for a project (variable dimensions, parameter
settings, levels, etc.).

Saving jobs will include the possibility to save a project file or a template file.

Recent projects are saved in a list in the File menu (Recent projects command). Selecting a
project from this list and hovering the mouse over will display a preview of the job graphics.

Stonex Cube-link v4.3 - User manual 8
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2.1.2 Imports

Cube-link allows you to import files in different formats, including the Cube-a format. To
import, just select a format from the list shown in the Import menu (Figure 2.2), each choice
will open a new window (for details refer to the paragraphs related to the different imports).

. Import different files into project
Import Cube-a

Import RWS/RAW

Import GeoGIS

# | Import/Open Cube-ink file
87 DXF/DWG files

& @) §

Import points from text file
BA | Map from web
ESRI Shapefile (shp)

Figure 2.2

m Home CAD Measures Topography Lines/Constraints

&> e 5 P & B &

Import Import Import Import Create Print Dxf/Dwag Dxf/Dwag
Cube-a RWS GeoGIS ASCII  map In Out
In/ Cut
Figure 2.3
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2.1.2.1 Import Cube-a

To import a Cube-a file you can select the relevant command in the File tab or you can click
on the Cube-a import icon in the Home tab (Figure 2.3). In case of importing Cube-a files,
the system can operate on single files or on files that are in specific folders. The second case
occurs when the user has access to the entire Cube-a project folder and selects the file with
the extension .pd contained in it.

In Cube-a, ajob is stored in a folder that has the same name of the project and has subfolders
containing all the data; the file to be imported is in the subfolder called "Data".

Copying the entire project folder allows the program to access data files such as photos and
reference system information. Within Android devices, projects are always stored as
subfolders of the "StonexCube/Projects" folder.

Figure 2.4 shows the main screen for exporting a Cube-a file. After selecting the file, a
reference system must be set up before proceeding. You can use the reference system
previously defined in the Cube-link (at start-up the program will automatically always check
if a default reference system has been set) or you can use coordinates defined in the field.
In addition, you can set up a local system or a default reference system, in which case the
program will allow you to access the relevant windows for the settings.

If there are photos in the file, you can transform them into GeoTIFF.

For leap seconds a default value is proposed which can be changed during the import phase.

Import Cube-a file

Select Cube-a file to import é} :LIhE E
1 L]

MName and path of Cube-a file to import:

Transform photos into GeoTIFF files

(@) Reference system defined in Cube-manager

() Local system...

(O) Coordinates defined on field

() Spedify Datum - Projection - Geoid...

Leap seconds
Mext = Cancel b 4

Figure 2.4
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2.1.2.2 Import RW5

To import an RW5 file you can select the relevant command in the File tab or you can click
on the Import RW5 icon in the Home tab (Figure 2.3). You will see a window as in Figure 2.5,
where you can specify the name and path of the file you want to import. A useful feature is
the ability to select the CRD file and then import only the updated data found in the field (if
you import raw files, the option on CRD files will not be visible).

Also, for this type of import the coordinates can be changed by selecting a local system or
a predefined system, or leave the coordinates defined in the field or use the default reference
system (set by the user when the program starts).

If you want to use the USB connection to import, click on Connect USB (the connection is
possible using the Windows Mobile Device Center program). The device used in the field
can be connected directly to the PC and through the window in Figure 2.6, it is possible to
directly download the files from the portable device to the PC or vice versa. By default, the
program always shows the folder with the recorded data, but this position can be modified
at will, clicking on the search button, you can then view the internal structure of the device
and select the desired folder.

Import RW5/RAW file

Select RWS5/RAW file to import

Mame and path of RW5/RAW file to impart:

Connect USE ﬂ.*

(®) Reference system defined in Cube-manager

() Local system. ..
(") Coordinates defined on field
() specify Datum - Projection - Geoid...

[] check tagged points on CRD file

Mext - Cancel b 4

Figure 2.5
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Figure 2.6
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2.1.2.3 Import Geogis

To import a Geogis file, you can select the relevant command in the File tab or you can click
on the Import Geogis icon in the Home tab (Figure 2.3).

If there are photos in the project, they can be transformed into GeoTIFF files. Furthermore,
even for GeoGis files it is possible to connect a device to the PC via the USB connection (with
the same logic and functionality illustrated in the paragraph concerning the importation of
RWS5 files).

With the USB connection even Raster, DXF and ESRI Shapefiles can be copied to the PC. To
do this, simply select the format chosen with the drop-down menu command at the top of
the screen.

For this format as well, it is possible to import the coordinates surveyed in the field or use
the default reference system, a local system or select a Datum. In the last two cases you will
have the possibility to access windows where to set the characteristics of these systems.

2.1.2.4 Import ASCII

To import a text file, you can select the relevant command in the File tab or you can click on
the Import ASCIl icon in the Home tab (Figure 2.3). This function consists of 3 steps.

In the first (Figure 2.7), you will have to select the file to be imported indicating name and
path, in this step you can also edit the file by clicking on the Edit file button (this choice will
open a simple text editor where you can edit the files and the number of lines can be
displayed or hidden). Before proceeding you can select the encoding and whether to create
topographic points or CAD points from the imported file.

In step n. 2 (Figure 2.8), you must choose the file format, either standard formats or a custom
one (Figure 2.9). Choosing the Custom format, you will have to enter a name for the format
and the separator character in the section below. The inserted custom formats can also be
deleted using the Delete selected command, located on the right, next to the drop-down
menu for selection.

Before proceeding to the next step, you must select the angular unit of measurement for
reading latitude and longitude and the row number from where to start reading the data (to
exclude a possible header, for example).

In step n. 3 (Figure 2.10), it is possible to assign the type of content (Point name, Coordinate

X, Y, Z; Description; Code; etc) to each column (click on the heading to display the list). This
will save the new layout with the fields selected, the layouts cannot be overwritten.

Stonex Cube-link v4.3 — User manual 13
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Import text file in graphics

Select file to import and data included into it...

Step 1of 3:

Mame and path of ASCII file to import:

Edit file &

Encoding:

® UTF-8
O asci
O cp-1252

Entities to import:
(®) Create topographic points (name, description, code, etc...)
(C) Create CAD points (3D location)

= Back Mext - Cancel b4

Figure 2.7

Import text file in graphics
Select the character used to slit data and the row to start reading. ..

Step 2 of 3

File format
Custom w Delete selected

Set the name of the new format:

Set the separator character: {character dividing the data to the same row)

(®) Comma () () Tabulation (TAB)

() semicolon () () space ()

() slash () () Group of spaces (text in columns)
(") Backward slash () () Other |:|

() Calon 2)

Set angular unit of measure (for latflon/h):

® Sexadesimal O oms O sexagesimal Start data import from row:
4= Back Mext - Cancel b4
Figure 2.8
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File format

Point name,Easting,Marthing,Elevation, Code W

Point name,Easting,Morthing, Elevation, Code
Point name,Morthing,Easting, Elevation, Code
Point name, Latitude Longitude, Elipsoidal h. ,Code

Figure 2.9

Import text file in graphics

Attribute to each column the contained type of data

Step 3of 3
Col. 1 Col, 2 Col. 3 Col. 4 . Cal, 8 Col. Col, 10 Cg™
Point name
110 724494,109 5037061... 58,57 i 03... 11°52'15.. 53,572 80,636 2
111 724434729 5037060.... 58.60 Easting D3.. 11°5715.. 58.605 50,665 2
112 724436,386  5037060.... 58,63 Morthing 03... 11°52'15.. 53.632 80,697 2
113 724437.068 5037060.... 58.641 Elevation 03... 11°52'15.. 53.542 80,707 2
114 724437.391 5037061... 58.64] Latitude 03... 11°52'15.. 53.547 80,712 2
115 724498564 5037064.... 58.53] D3... 11°52'15.. 58.637 80,701 2
116 724437.266  5037066.... 58.55 Lengitude D3.. 11°5715.. 58.563 50.627 2
117 724497.239 5037058.... 58.541 Ellipsoidal h. D3... 11°52'15.. 58.542 50,706 2
113 724504.317 5037060.... 58.52 ECEF X D3... 11°52'16... 58.627 50,692 2
119 724504.408 5037060.... 58.52( D3... 11°52'16... 583.620 60,685 2
120 724505.184 5037060.... 58.59 ECER D3... 11°52'16... 58.599 60.663 2
121 724504.108 5037059.... 58.59 ECEFZ 03... 11°52'15... 58.595 60,652 2
122 724505,447 5037058.... 58,533 Description 03... 11°52'16.. 58,533 50,598 2
123 724506,138 5037057.... 58,523 Code 03... 11°52'16.. 58,523 80,587 2
124 724515,165 5037053.... 58,71 03... 11°5216.. 58,712 80,777 2
125 724515,270 5037053.... 58.70 Delete 03... 11°52'16... 58,709 80,773 2
126 724514.706 5037053.... 58.7 w5=z703,.. 11°52'16,.. 53.722 80,736 2
127 724516,912 5037053.... 53,708 45°2703... 11°52'16.. 58.706 80,770 2
123 724434.747 5037056.... 53,790 45°2703... 11°52'15,.. 53,790 80,554 2
129 724439,328 5037045.... 58.881 45%2703,,, 11°52'15,.., 53.881 80,545 2
130 724499582 5037046.... 58,855 45°2703... 11°52'15... 58.855 50.920 2
W
£ >
= Back Mext = Cancel b 4
Figure 2.10
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2.1.2.5 Create map

To create a map, you can click the Map from web button on the File tab or you can click on
the Create Map icon in the Home tab (Figure 2 3).

This function imports a map into the project, it will require the East and North that you want
to set as the center of the map. You will then see a window powered by Google Maps as in
Figure 2.11. To import the map into the CAD you will need to save the image as jpeg. The
services for creating maps are two: Google and Bing. The window and the creation occur, in
both cases, in the same way. If the created images do not cover the area in which you want
to create the map, you can increase the horizontal and vertical images, or you can proceed
to create a new map in addition to the one created. The program will overlay the geo-
referenced images.

The images downloaded using these services are subject to copyright and in the case of
Google maps it is possible that after a quantity of free downloads the service requires a
payment.

& Cube-link maps O
Cube-link Maps - powered by Google Maps a3 X
ose
Center of the map: Lat. = 45.6015283809633 ; Long. = 9.23888270222238
Google Maps  Bing Maps
Horizontal images = |3 ~ | Zoom factor = 18 v g Create Map E’Q Save image L:“ Import on CAD :
C )

Vertical images = 3 v | Type of map = Mix

( Map extension = 100x 100)

T R T, .

. SVArosio Produz% 4
S Cucine

\ Senso!Unicol™ 7

Abbigliamento Lissone

&

Pt vy L g I @FUrniture store
o e AT Viawittorio Alfieri 4 osfere Etnodada
% \fiz i 0 =
jVia\Vittori 4 Pharmacy, & gl
L Far

Hat shop

- n
lificio Duemme = " & W v

Figure 2.11
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2.1.2.6 Send to AutoCAD

Availability Module
Cube-manager P-T-M
2.1.2.7 Print

The Print command generates a window that includes three tabs: Print settings; Printing
styles; Printing tables. Print Settings (Figure 2.12) is the tab where you can set the printer
you want to use and the page you want to print. Even the scale, origins, print area and print
size can be set in this section.

In the Printing Styles tab, you can set the thickness, terminations and joints, using the layer
settings or creating new styles. You can also import previously saved styles or save new ones
(Figure 2.13).

The last tab Printing tables is dedicated to saving, deleting or loading print tables. In each

of the tabs just described, you can click on the print preview button (Preview and print) to
see a layout of how the file will be printed.

Stonex Cube-link v4.3 — User manual 17
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Print

Print settings  Printing styles  Printing tables

Set printer and page: Print area:
| HP LaserJet P1006 b | (®) Print drawing extension
Size set: ) ’ )
Set page | i () Print window Select window

‘ A4 Vertical
‘ Advanced printer settings | 210x 297

X max.: | 10.000
Scale, origin and print size: Ymax: |TONER
Printing scale: 1:200 “ | Set origin:

X min.: -10.000

100 mm ¥min.: [-10.000
| Center in the sheet | Limit printing to single window
100 mm
—
Preview and print = Exit b 4
Figure 2.12
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Print
Print settings  Printing styles  printing tables
(®) Use layer settings Layer Manager @c—:
(T Use print styles
Print style settings table
Video Print Thickness Terminations Joints ™ Open style ﬁ
P 0 __ 0.10 “|Truncated |“|Join k4
1 -- 0.10 ~ |Truncated |~ |Join hd
2 2 2 0.10 “|Truncated |¥|Join o Save style E‘;&.
-- 0.10 ~ |Truncated |~ |Join hd
0.10 “|Truncated |“|Join k4
0.10 ~ |Truncated |~ |Join hd
0.10 “|Truncated |“|Join k4
0.10 ~ |Truncated |~ |Join hd
0.10 “|Truncated |“|Join k4
0.10 ~ |Truncated |~ |Join hd
0.10 “|Truncated |“|Join k4
0.10 ~ |Truncated |[v|Join Gl W
Preview and print E Exit b 4

Figure 2.13

2.1.2.8 DXF/DWG

This function allows the system to import the graphic elements as they are and since there
are no topographic points in this type of file it is possible to force this choice, so that the
entities with attributes become topographic points (Figure 2.14).

If you decide to import by transforming the points into topographic points, you will have
the possibility to establish the name (sequential) of the points and the properties of the
imported block. You can also select the option to import points on a single layer, in this case
the current project layer will be selected.
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@ Import DXF and DWG files — x
Select import options for DXF or DWG file

Options to import DXF and DWG files

[] impart all on one layer {current)

Transform point entities into topographic paoints

(® Sequential peint name starting from: 100 |

() Point name from first block attribute

() Properties of point from block attributes:

Attribute for Name [NAME |

Attribute for description [DESCRIPTION |

Attribute for code [CODE |

Description of default points |D'X{F point |

oK v Exit p 4

Figure 2.14

2.1.2.9 Pregeo

The program supports the processing of Pregeo files, but this function is only visible in the
Italian version. To access it, just set the Italian language from the change languages button.
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2.1.2.10 Digital map extract EMP

Availability

Module

Cube-manager

P-T-M

It is possible to import a file with the .EMP extension simply by indicating the name and path
of the file from the screen that will be generated by clicking on the EMP Digital Extract
command from the File tab (example of a project with imported EMP extract Figure 2.15).
This is a Pregeo function (italian).

w2
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Figure 2.15
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2.1.2.11 ESRI Shapefile

The import of a shapefile generates a screen like the one in Figure 2.16. Clicking Open at the
top right you will see a preview of the work you are importing, on the left you will see the
layers that make up the file. By clicking Import you can finish the preview and re-enter the
graphic view in the main window.

¢ Import Shapefile O X
e Unit of measure: Map below:
15 mport @, Zoomin Q o ¥ P ] Limits 52 Measure ¥ Close Meters <1 TNare >
Layer File preview (area to be imported in below window)
Name Color  Name —_— %=869323. 38; y=585362.11
roadeop ™ 11

1.3 km
4000 ft

X 869323385 Y: 585362 111 C:\Users\ibucci\Documents\CubeOffice Projects\test\SHP \roadeop shp

< >

Figure 2.16

2.1.2.12 Features of GPS points

Whenever you decide to import GPS points into the program, Cube-manager will
automatically display a screen, as shown in Figure 2.17.

From this window it is possible to set the graphic appearance of the points, subdividing them
according to the type of solution that characterizes them. It will then be possible to set the
layer, the color and the icon of the symbol, divided by type of points. The size of the symbol,
the font and its color can be set for the total number of points that are being imported.
Note: GPS stations are by default positioned on a non-visible layer, however it is always
possible to reactivate the layer, and set the color and icon of the symbol.
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Features of GP5 points (default)

Stations

Fixed

Float

SBAS
DGPS
Single
PPP

Kinematic

2.1.3 Export

[ prevalence of features defined in field

Layers Colors Symbols
[ visible
T ¥ _ Symbal size
2,000
Font
GPSdgpsPoint R _ Text size
Text calor
Confirm v Cancel b4
Figure 2.17

Cube-link supports various export formats, in Figure 2.18 all possible exports are
summarized. To access the exporting in various formats, click on the Export command in the

File tab (Figure 2.1).

. Export project to a different format
Export in Cube-a

Export in RWS
Export in GeoGIS
DXF/DWG files

moe g @

Export points on text file

Export in Google (KMZ file)
ESRI Shapefile (shp)

Figure 2.18
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2.1.3.1 Export Cube-a

To export in Cube-a format, simply select the name and path of the file to be created, by
default the program exports both graphical entities and topographic points. However, it is

also possible to exclude graphical entities and to export only topographic points (Figure
2.19).

Export

Export to file: Cube-a

Mame and path of the file to be created

(® Export al

(") Export only topographic points

Proceed - Cancel b 4

Figure 2.19
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2.1.3.2 Export RW5

To export in this format, you must select a file name and path, optionally you can also create
an EzSurv file, you will always need to select a file name and path. You can also create a CRD
file associated with the created RWS5 file (Figure 2.20).

Export

Export to file: RWS5/RAW

Mame and path of the file to be created

Mame and path of Raw Data file (EzSurv) - Optional

[] create crD file

Proceed - Cancel b4

Figure 2.20

2.1.3.3 Export GeoGIS
The export of a GeoGlIS file is like the export of a Cube-a, it will be necessary to set a file

name and a path. By default, both points and graphic entities are exported, but it is always
possible to exclude the graphic entities from the export.
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This export is the only one that can be recalled from two different commands within the
program. First command is into the menu in Figure 2.18, like all other exports, the second is
the Dxf/Dwg Out command in the Home tab (Figure 2.3).
For a correct exporting, the first choice to make is the version of AutoCAD® that you want
to use to create the file. Then you can select the options on the entities, especially if you

want to include Raster images, backgrounds and topographic points.

In case of simple topographic points, not as INSERT, the window on the right called Options
for displaying points will be enabled. In this section you can set the size (as an absolute
value, as %5 of the drawing area or as a percentage of the viewport) and the symbol for
viewing the points in AutoCAD®. In the general options section, you can enter the text size

and choose to create a 2D DXF file (Figure 2.21).

% Create DXF / DWG files

Entity options

Indude raster images

Indude hatches

Include topographic points

] Export symbols/Points as INSERTS

Point name

Description

Paint code

Height

X coordinate

¥ coordinate

Containing layer

Retrieve attributes from point label
Attributes on different layers

Add point (separated from the block)

Add name (separated from the blodk)
] Add height {=eparated from the black)
] add a description (separated from the block)

DWG options
AutoCAD Version:
AutoCAD 2000 ~

General options
Text size

0 Create 20 DXF file
(Set all heights to zero)

Simple texts (TEXT)

Options for displaying points

Dinension

(") 5% of the drawing area height
(®) Absolute size
() % of the viewport size

Symbal | « Point V|

Create dxffdwa

v Cancel b4

Figure 2.21
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To create a text file just click on the Export points to text file button (Figure 2.18). The creation
of the file is customizable, and it is possible to define the characteristics that you want to
give to it: you can choose whether to include a header, the data to be inserted, the separator

character, the format of the geographical coordinates etc. (Figure 2.22)

@ Create ASCI file

Select options for creating the ASCII file

ASCII file creation options

[] Header
Indude the following data:

Character used to split:

D (or) []Tab

Point name

East/Morth

Height

Description

[] Point code

[] Latitude Longitude

[] Ellipsoidal h. on the ground

[] Ellipsoidal h. of the phase center

[] Invert X with

Geographic coordinates

@ 0g°pp'ss.ssss”
() ga.dddddddddddd

[] Pole height
E State Characters on start of line
FDOP
[] HDoOR | |
[] vDop Characters on end of line
] eDop | |
[] TGP
Ok v Exit
Figure 2.22

2.1.3.6 Export an image file (bmp, jpg, etc.)

Availability

Module

Cube-manager

P-T-M
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2.1.3.7 Export in Google (KMZ)

By accessing the Export to Google (KMZ file) function, you can generate a KMZ file that can
be viewed in Google Earth, this export is possible only if there is a fieldbook in the current
job. The procedure is like the other exports of this application; first specify a name and a
path for the file, then proceed with selecting the features you want to add. The structure of
this window is very flexible because you can indicate which data to export; including CAD
elements, GPS data, photos, database attributes. As soon as the file is created, the program
will ask if you want to load it directly in Google Earth (Google Earth must have been
previously installed in the PC).

2.1.3.8 ESRI Shapefile (shp)
The steps for creating an ESRI shapefile file (Figure 2.23) are like those applied to the export

of other formats, once selected the name and location of the file to be exported, you can
select a series of information and contents that you want attribute to the file.

Export Shapefile

Export to SHAPEFILE

Mame and path of the Shapefie to be created

[] Export to geographic coordinates {points only) [] Transfer heights

Shapefiles to create (files with the same name will be overwritten) Elements to be transferred to the DEF file

Graphic elements (points)

Measure GPS data [ Fieldbook (points)

Database tables

Photos

oK = Cancel b 4

Figure 2.23
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2.1.4 Settings

In Settings (command in the File tab), you can set the general program functions, such as
checking for updates at startup or the version of AutoCAD® to be used (Figure 2.24). This
function consists of 4 tabs that will be discussed below. It will allow you to completely
customize the aesthetic, functional and practical aspects of the program. Note: to make sure
that the changes are effective, after changing the settings, it is advisable to restart the
program.

Prograrn settings

General Appearance Help System

General program settings

Check for updates at startup
Enable autosave every minutes

Graphic interface

Toolbars font size 9,75 e
Data grids font size 2.00 -
AutoCAD ®

AutoCADE version in use:
AutoCAD ver, 2019 w

ok v Cancel 3

Figure 2.24

In the Appearance tab (Figure 2.25) you can determine, for example, the background color
of the work area or enable dynamic information on the cursor.

Among the other functions available there is the possibility to enable/disable the dynamic
list of features, the display of the thicknesses on the screen, the size of the Cartesian axes'’
icon.
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By enabling the dynamic list of features, you can read the characteristics of the elements in
the project. If you hover the mouse over the elements, the application will display a popup
window, like the ones below (Figure 2.26), which will describe the type element and its

characteristics.

Program settings

General Appearance  Help System

Appearance and functionality of CAD warkspace

255 |

Graphics background caolar |
Cursor axes size |15[J %o
Cursor axes rotation |D.DDDD

Wheel zoom magnification factor |1I][J

Dynamic information on cursaor

|Measures + Input + Instru ~ |

Raster images gualit Standard

Enable/Disable dynamic list of features

[] Enable Dizable the display of video thicknesses

Enable/Disable cartesian axes icon

Display solid faces of OTM triangles (30 faces)

Display raster images border

Display raster images during dynamic zoom

Display raster images in 30 graphics

Display selection break in level curves

Ok

Figure 2.25

- CAD entity -
CIRCLE

Cancel

Layer: LAYER_DEFAULT
¥eor-14.924

Yc: 3.003

Zc: 0.000

Radius: 3.503
Circumferance: 22.012|

- Topographic point -
MName: 1

Area: 38.558

Layer: LAYER_DEFAULT
¥ -4.412

¥: -1.559

£ 238.670
Descrnption: Fence
Code: FN

Figure 2.26
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The Help tab (Figure 2.27) is useful for setting the use of the Object Snap and in which mode
and whether to enable or disable polar pointing and Ortho mode. Furthermore, in this
section it is possible to customize the size of the Osnap symbol and the size of the selection

area when this mode is active.

Program settings

General  Appearance Help System

Help on drawing
[] Enable/Disable Ortho mode
Enable /Disable Object snap (OSMAP)

Object snap mode:

\‘- Endpaint

i1 Topographic point
] .+ Midpaint

|:| IE:I Center

] E:EI Quadrant

Ry .
. Intersection

[] % Nearest

[] -L- Perpendicular
] (4 Tangent

[] " Parallel

] ™., Extension

i Orthogonal on 30 face

Reference agrid oy Cloud paint
Osnap symbal size pisxel
Selection area size pixel
[] Enable/Disable polar pointing
Polar pointing point 50,0000
Ok v Cancel 2
Figure 2.27

In the System tab it is possible to set the topographic unit of measure and the decimal
figures for the display of parameters such as heights, coordinates, distances, etc.

Regarding the representation of the angles, which is a setting in this section, there are two
possibilities: the representation of the topographic angle and GPS and the representation of
the general angle, which concerns the graphics. The representation of the angle relative to
the topography is set by default in Grads but when a fielbook is imported, the application
will read the configurations of the job and set the representation accordingly.
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From the File tab, the Set Graphic Styles command (Figure 2.28, Figure 2.29) is available in

the program Cube-manager.

Set style for graphic entities
#  Line settings

#| | Hatch settings
#. | Point style
==, Print style

/| Dimension style

=,

Figure 2.28

Line type editor

| Command

|| 0.024; -0.058

|List of line types

Trees line (firs)

Name of the line type:

|Trees line (firs)

Type of filet

With continuous line

Line types manager

Add line type

Line type editing

Delete line type

Import Cube-manager file [

Figure 2.29

Exit
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From the File Tab it is also possible to access the Upload utility files function which has the
purpose of uploading files of three categories (Figure 2.30): image files, database files (only
available in the program Cube-manager), geoids.

Upload utility files
Upload image file

Upload geoids

Figure 2.30

Fieldbook list

Fieldbook Type Stations Foints
o ——
® 2018139.PD
W
Delete fielbook ]ﬁ] 0K -p Cancel b4

Figure 2.31

You can check how many and which fieldbooks are present in a job by accessing the
Fieldbook List function. In Figure 2.31, the information displayed is: the name of the
fieldbook, the type, the number of stations and the number of points. The operations that
can be performed are: change the visibility of the fielbook (by clicking on the light bulb icon
on the left) and delete the fielbook. By deleting a fieldbook it is also possible to delete the
topographic points contained in it.

The last two commands in the File tab are: Check for updates and Activate Cube-manager.
The first command is for manually check if program’s updates are available. Every time the
application is started, an automatic check will be carried out to check the availability of new
updates (default choice, it can be changed from the Settings section). However, you can also
manually check for updates by clicking the button described above. If an update is available
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and you decide to download it, the program will ask you to select in which folder you want
to save the executable file, after which the download will start automatically.
The Activation Cube-manager button is available only in the program Cube-manager.

2.2 Home (tab)

The Home tab is located at the top of the main screen and contains several sections (Figure
2.32), including the In/Out section (Figure 2.3) described in paragraph 2.1.2, which contains
all the formats available for import into the program.

CAD  Measures Topography Lines/Constraints 3D Models Raster  Post-processing

= =» ‘e [Ch N/ — & = —_— o q ) N =
= @ M L= m ﬁ] e & # on point I_D [L:_I; %o @ From entities e
Import Import Import Import Create Print Dxf/Dwg Dxf/Dwg | Limits Window =1 Magnifier Copy Paste | Manage &9 Move on current Language
Cube-a RWS GeoGIS ASCIL  map In Out Q zoom . e Madify... -
In/ Out Zoom Clipboard Layer DB Language
Figure 2.32

2.2.1 Zoom, Clipboard

The Zoom section contains numerous commands for zooming and selecting items in
graphics. The commands are: Limits, Window, On point, Magnifier and Zoom that allows you
to access a submenu to select the zoom in, zoom out or dynamic pan of the graphic (Figure
2.33). In the Clipboard section you can find the classic copy-paste function.

=l ro On point

& @ doreent 1A

Limits Window k1 Magnifier Copy
Q Zoom ... -

£0 Q Zoom in

* from la

Zoom out
w Dynamic pan
Figure 2.33

Stonex Cube-link v4.3 — User manual 34



©

STONEX

2.2.2 Layer

The Layer section is used to manage the various layers in the project. By clicking on the
Modify button (Figure 2.34, red circle), you can access the window in Figure 2.35, where you
can operate on layers with visibility, selection or block functions.

Layers can also be managed via the Layer Properties Management window, which can be
accessed by clicking on the related icon on the main screen (Figure 2.36). In the layer
properties window (Figure 2.37), you can create new layers and delete others (in order to
delete a layer this must not be used and deselected, a layer is not used when it does not
contain graphic elements or topographic points).

This window displays all the available layers and their classic characteristics, such as color
and type of line, from here you can print the contents of a layer and decide whether to show
the names and symbols present (by clicking on the eye icon). You can also operate on
visibility (light bulb icon).

@ iti
o) @ From entities

Manage & Move on current

Layer

Figure 2.34

Isolates selected layers
Turns off selected layers
Locks selected layers

Activates all layers

ﬂ:‘r@ "ﬂ H.‘rﬁ -Q ;«

Unlocks all layers

Figure 2.35

Figure 2.36
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Layer property manager
Mew ﬁ_ Delets Q _ Search Q
Sel,  Mame OnfOff Lock Color  Line type Scale Thickness Frint Mames  Symbols

RSl L~ "ER_DEFAULT r o EN 1 0.10 = - o

2 point r & KN 1 0.10 J | = | @

3 GPSRefStations * & KN 1 0.10 B e o

4 GPSsinglePoint * &4 KN 1 0.10 B e e
OK. v Cancel b 4

Figure 2.37
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2.2.3 DB
Availability Module
Cube-manager (Figure 2.38) P-T-M

Create database

Databasze
|C:‘l,ProgramDa13‘!,5tonex‘l,Cubemanager‘lDaE‘lSampﬂe Database.att

Record Attributes List of elements

| perimeter (m)

[ date
[ hour
[ owner
{SRMPLE) BUILDING -p
[ type
| commercial
I industrial 'h
I residential
| warehouse

[ street code
[ heating system
I autonomous
I centralized
[ car access

H ; Set
DEF
13 W
1 1 1
SEE « ~ i ¢+ 3 = s B
Device attribute folder
|\Program Files\GeoGIS\Data | ¢ E
Figure 2.38

2.2.4 Language

By pressing the language button, you can select the language of the program. We
recommend restarting the program after changing the language.
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2.3 CAD (tab)

By clicking on the CAD tab (Figure 2.39), it is possible to access the area dedicated to design
and CAD processing, which aims to support and integrate the topographic elements.

These functions are like AutoCAD® ones and its many clones. This section is divided into
two parts: draw and modify. In the Draw section (Figure 2.40) you can find commands to
draw CAD entities such as lines, polylines, polygons and so on. Once you have selected the
element you want to draw, just follow the instructions (represented by the suggestions that
will appear on the screen and/or before the command line) to complete the command
(Figure 2.41, example of a suggestion on the screen for drawing a line; Figure 2.42, example
of a suggestion before the command line).

Often, with the suggestions before the command line at the bottom left of the main screen,
other subcommands are available (to the right of the command line). When the
subcommands are visible, to use them just write them in the command line and click on
enter (or simply click on them).

The subcommands are very intuitive to use, however there is a command that is worth
analyzing, the ‘pro’ command for properties (Figure 2.43, second command from the right).
This command opens the Quick entities selection window (Figure 2.44), which consists of
two tabs. The first tab called ‘CAD entities’ allows you to select entities by referring to one
feature or another, e.g. color and type of line. The second tab is called ‘Topographic Points’
and allows you to select the points based on their characteristics. As you can see in Figure
2.45 a wide range of attributes is available, from points with a given point symbol to point
in the same fieldbook.

m Home | CAD Measures Topography Lines/Constraints 3D Models Raster Post-processing
y . 2 S~ e & - & Copy '
. ol ) Ve = Re.[tang, . . solect rio) < + Move Fillet Trim & Explode ) opy prop. A Send to back
Line Polyline Circle Arc <> Ellipse .~ CAD point Multilin. points | Properties Delete [ Copy Join - Extend % Group  £1 Editpoly. ~ i cut b ind
Polygon 3 Rotate f Offset (7 Break s Ungroup M Bring to front ™ vt boxwindow
Draw Modify
Figure 2.39
L] L] s ™ G
e ' L "™ [ Rectan teei
. *—e s e o Select
H i e . o i . 0 i ili :
Line Polyline Circle Arc <> Ellipse =~ CAD point Multilin. points
- - 3 Polygan
Draw
Figure 2.40
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¥®.v.(Z) end line / length / fenld drawing

Figure 2.41
| N} N —
¥ y.(z) end line / length / {en}d drawin [+]-] — en
Bl e gth / {en)d drawing | 88 =1
Figure 2.42
ii Select the entities to rotate ({conflirm / [pro]perties / points [fil]ter) || |E Eg 1 conf 2 pro 3 fil
Figure 2.43
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% Cuick entities selection >

CAD entiies  Topographic points

{®) Entities of the layer: | Select layer. .. |
() Entities that have the following color: | Select color... |
() Entities that have the following line: Select line type... w
() Entities of the following type: Select entity type... w

() Overlapped CAD texts

Select = Cancel p 4

Figure 2.44
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% Quick entities selection >

CAD entiies  Topegraphic points

(®) Points of the layer: | Select layer. .. |
() Points whose text is of the following color: | Select color... |
() Pointz with following symbal colar: | Select color. .. |
() Points whose symbol is: e

() selection by point table

() Close and,for overlaped points - Search Radius: |

() Points whose description indudes: |

() Point code corresponds to: |

|
|
() Points whose code contains: | |
|
() Points whose name. .. Begins with... ~ |

() Points of the fieldbook: Select a fieldbook. .. w

() Points with associated resource (image)

Select = Cancel p 4

Figure 2.45

The commands in the Draw section can be used with OSNAP (object snap) functions, such
as OSNAP on the ends or midpoints. Note that by default the program starts with an OSNAP
active on the ends. This setting can be changed at any time by clicking on the Osnap (on/off)
button at the bottom of the main screen, shown in Figure 2.46 in dark gray (active).

All the OSNAP modes are represented by the icons in Figure 2.47, passing with the mouse
on them you will see a suggestion on the functionality of the command.

| N |
b Ol =
‘ !! Command: | | g =
Meters | X =-24.260 ; Y =-10.547 ; Z=0.000 Elev.0.000 Ortha Polar Thickness [£3 Reference grid |25= Tools bar
Figure 2.46
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Figure 2.47

In the Modify section of the CAD tab (Figure 2.48), you can find all the functions for
processing CAD entities. The names and the icons of the commands are very intuitive, and
each command has a tooltip that briefly explains what its functionality is. Among the
available commands there are explode, group, ungroup; these commands are useful for
working with CAD entity groups. The Cut box window command generates a window as in
Figure 2.49, where it will be possible to create a new job by selecting a portion of the window
of the current job, the cutting window can have a frame with customizable graphic
characteristics and layers.

The Properties button generates a window that summarizes the properties of the selected
entity, the system recognizes what type of entity it is and at the bottom it shows this
information (Figure 2.50, in this case it is the properties of a polyline).

There is also a command to copy the properties of one entity on another and a command
to change the order in which the drawings are displayed.

,
AT { + Move Fillet ~ Trim & Explode & Copy prop. M Send to back
Properties Delete ™ Copy Join -~ Extend % Group  ¢1 Editpoly. -~
i . ) i1 Cut box window
3 Rotate = Offset 07 Break = Ungroup ™5 Bring to front ™
Modify
Figure 2.48
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Cut box window

Mame of job |Job2] H |

Min ¥ |—1n.:r'35

Min Y |—3.2sn

Max X |3.?52

Max ¥ |?.92;3

Draw cut box

Layer cutbox |LAYER_DEFAULT || |

Thickness cut box |1 w |

Createnewijob Cancel »

Figure 2.49
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CAD entity properties
Graphic layer [LAYER _DEFALLT | ~
Line type | hd |
Thickness |':'-:"":I bl |
Closed polyline |m e |
| |
| |
o W
< >
Polyline Properties
oK v Cancel 3
Figure 2.50

Figure 2.51 shows a popup window related to the Edit poly command. The submenu contains
commands for modifing the polylines, for example by inserting a vertex or by removing it.
The use is very simple and, like any other CAD command, just follow the suggestions that

appear on the screen.

£1 Edit poly. -
Insert vertex

Remove vertex

Merge 2 polylines

Assign height to points

Figure 2.51
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2.4 Measures (tab)

The functions in this section (Figure 2.52) are used to calculate and display information on
surveys’' data. This section is divided into three areas below: Measure, Calculations,
Dimensions (available only in the program Cube-manager).

m Home CAD  Measures Topegraphy Lines/Constraints 3D Models Raster  Post process

N e I T
L o &=

Coordin. Distance Angle Area i= Entity list
Measure Calculations Dimensions
Figure 2.52

The Coordin. button will give the possibility to choose a point and then show the Cartesian
coordinates (with the addition of the height) of that point, as shown in Figure 2.52.

Point info >

Cartesian coordinates:
¥=-14282

¥=3479

Z = 307.560

Figure 2.53

The Distance will give the possibility to select two points and measure the distance between
them. The information provided by this function is the 3D distance, the horizontal distance,
the components along the three axes, the azimuth angle and the zenith angle (the graphic
appearance of this information is like that one shown for the Coordin command).

The Angle button will give the possibility to select 3 points: the start point, the midpoint and
the end point. This function will calculate a clockwise angle and a counterclockwise angle
(the graphic appearance of this information is like that shown for the Coordin command).

The Area button will allow you to insert the first point in which to start calculating the area,
then the application will continue to ask to select the next point (up to n points) to draw the

shape for the area measuring; after selecting the last point, just type the command "en" (in
the command line, from the "end" command) so the function will compute the calculation.
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The area and the perimeter of the drawn shape will then be displayed in a popup window,
with a graphic like the one shown for the Coordin command.

The Entity List command, in the Calculations section, provides a list of the elements in the
project, the list is presented as an editable text file. It is also possible to select just a part of
the entities to display them in the list (Figure 2.53).

% Text editor O X
0 - Topographic point - ~
1 Name: 110

3 Layer: GPSfixedPoint

4 X: 724494.109

S ¥: S037061.090

6 Z: 58.572

1 Description: fence

8 Code: FC

9
10

- Topographic point -
Name: 111

Layer: GPSfixedPoint
¥: 724494 .729

¥: 5037060.789

Z: 58.605
Description: fence
Code: FC

- Topographic point -
MName: 112

Layer: GPSfixedPoint
X: 7244%¢.38¢
¥: 503706e0.561

T et i S e R S S, [

Display line numbers Exit x

Figure 2.54
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2.5 Topography (tab)

The topographic section (Figure 2.55) consists of four subsections: Topographic points,
manage coordinates, Fieldbook and Fieldbook schema (available in the program Cube-
manager). In the Topographic points it is possible to draw a new topographic point, to
modify the characteristics of an existing one, to select the CAD entities to be used to create
new points and to see all the points of the project grouped in a table. The Various operations
command, if clicked, opens a drop-down menu with the commands as in Figure 2.56 (the
Edit symbols command is not available in Cube-link). In the Fieldbook section there are the
commands to work with polar fieldbooks. You can manually create a fieldbook, import it
from the PC or import it directly from the total station and export coordinate files.

m Home CAD  Measures Topography Lines/Constraints 3D Models Raster Post-processing
e . . a z p— = —_
g+ £ ® Properties {/// @ I\\ vAx 7 El,. Eh - 0
Mew Points from ¥ Point table Various Referance Rototranslation  Coordinates | Edit fieldbook  Import Export Leveling
CAD entities - operations - system - conversion - + fieldbook~ coordinates-
Topographic points Manage coordinates Fieldbook
Figure 2.55
Y,
e
/d
Various
operations -

55‘5 Rename points
1 # | Text properties
[ & | TextOffset

il #.| Edit symbols

Figure 2.56

2.5.1 Topographic points
The Topographic points section is shown in Figure 2.57. The New command is used to insert
new topographic points, by clicking on this button, you can access a window (Figure 2.58,

Topographic point properties), where you can insert and customize the graphic properties
of the created point.
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The properties are completely customizable (note: it is possible to create a point with the
properties that the application sets by default, e.g. the cross as symbol) and you can select
the layer to which the point must belong (by clicking on search button next to the Graphic
layer label). The Select Layer window (Figure 2.59) shows a list of available layers, all of which
can be activated or deactivated, locked or selected. You can add new layers by clicking on
the Add Layer button on the bottom left.

You can also change the name of the point and the font used. You can also change the text
color selecting a new one in the window in Figure 2.60, by clicking the search button next to
the Text color label. This window allows you to select a color from one of the available
clusters (general colors, grayscale, main colors or layer).

i.'. _:_::' ‘® Properties ;_r?':’}
New Points from 8 Point table Warious
CAD entities - operations -

Topographic points

Figure 2.57

Topographic point properties

Point name | 1 |

Graphic layer |L.-5.YER_DEF.E'.LILT

Fant | Arial

Text size (in ems) |4.EIIZIEI |

Text color

Paoint symbal —I— Cross iy

Symbal size | 2.000 |

symbol coor |

Symbol angle {gon) |III.I:IIIII:II:I |

Description | | E

Point code | w |

Offset X point - text |1.100 |

Offset ¥ point - text [0.667 |

Ok v Cancel 4

Figure 2.58
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List of graphics layers:

Mame

OnfOff Lok

Color

LAYER _DEFALLT

point
GPSRefStations

w
E O N

GPSsinglePoint

3
Add Layer $+

Select W

Figure 2.59
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Select color

General color chart:

Main colors: Selected Color:

Grayscale: Logic:

HEBEB From layer | R=128: G=128: B=128 |

Pregen:

. . Select & Cancel ¥

Figure 2.60

The symbol is another feature that can be customized. You can choose a symbol to assign
to the point (Figure 2.61, drop-down menu for symbol selection), you can define its size,
color (with a selection window equal to the text color selection) and the rotation angle of
the symbol.

Offset X point-text and Offset Y point-text are the text positions calculated from the origin
of the point (If not entered directly, the value of the xy offset is calculated based on the
values of the text height and symbol size, so that the first line of text is centered with respect
to the symbol).

As for the Description label, by clicking on the icon next to the label you will access a window
where you can view a list of possible descriptions (Figure 2.62). You can select existing
descriptions or add new ones, saving the file with the destination to be specified. If a similar
file has already been saved, you can select it and display it to use it.

When all the graphic properties have been set, it is possible to insert the point by identifying
the position with the mouse or by manually entering the coordinates from the command
line.
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Figure 2.61

Information list

Center
Corner

Cover
Ditch
Driveway
Edge
Entrance
Fence
Garden
Gate
Home
Lake

Left bank
Left Side
Manhole
Mail
Metwaork:
Marth side
Marth side
Picket
Fole

Right bank
Right =ide
Right =side
Road
Sidewalk
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£

Selected information

Confirm information  +* Add information ==

|Sa'u'e information list in custom file R |

Cancel

Figure 2.62

X

Stonex Cube-link v4.3 — User manual 51



©

STONEX

The COGO commands (Figure 2.63) are available in the program Cube-manager.

COGO Points from  Propertie
points © CAD entities ™

Ll Middle point
- Intersection point [

» Projection point i

1l Fourth point on rectangle

. Extension point

|-+  Orthogonal point

E-f Polar point

| = Pointon arc

| " Points on circular curve

“"  Intersection of slopes

Figure 2.63

By clicking Points from CAD entities (in Figure 2.57), you can access two commands:
Characteristic Points and Equidistant Points or with steps (only available in the program
Cube-manager). Using the first, you can select one or more CAD entities to create
topographic points. In the Characteristic Points window (Figure 2.64), you can select a layer
(having access to the Select Layer window, as explained above). You can enter the name of
the starting point and delete the overlapping points. Within this function you can further
filter the CAD entities to be used by marking the available choices.

The second command, the Equidistant Points or with steps, can be used to create
topographic points by dividing a CAD entity into equal parts or based on a step, to use the
command just follow the instructions that appear next to the command line.
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& Characteristic points >

Select CAD entities to use to create
new topographic points

Characteristic points

Layer |LAYER_DEFAULT

Starting name for points Pt102

Delete overlapping points

CAD entities to use for new paints:

[] Extremes of lines [] cAD Points

[] mid-paint of the lines [] center of the drcumferences

[] vertices of polylines [] center of the arches
Vertices of hatches Texts insert point

Vertices of 3D faces

oK v Exit

Figure 2.64

Returning to the section in Figure 2.57, the next command to explain is the Properties
command (Figure 2.65), once you have selected one or more topographic points you can
use this function to discover all their properties and to modify them.

This window consists of four tabs: General, Graphics, Coordinates, Image.

In the General tab you find information about the name, description, point code. From this
screen you can set the information displayed in graphics as point label (point text). To
change the label of the point just select the items you want to insert from the drop-down
menu and press the insert button (one item at a time), you can also set the X and Y offset of
the point text.

The Graphics tab provides information about the font (font, size, color) and the symbol (icon,
size, color, rotation) of the point.

In the Coordinate tab (Figure 2.66), you can read the coordinates Est, North and Quota (as
average of the coordinates of the various origins of the point), with the relative standard
deviation. You can change the coordinates manually by selecting the fixed coordinates
command. In the table called Origin of the coordinates, the origins of the selected point are
shown, for each origin the name of the fieldbook, the type of origin, the station from which
it is measured, and the coordinates are reported.

The buttons below the table are: Create new point from selected origin (available only in
presence of multiple origin); Properties of the selected origin (opens a screen as in Figure
2.65, where you can view all the information related to the point, some are editable other
read-only); Fixed coordinates from selected origin.
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The Image screen allows you to see if and which images are associated with the selected
point.

Properties of the topographic point *120°

General  Graphics Coordinates Image

Paint name | 120 |

Diescription |Er1h'anoe |

ENl V|

Point code

Graphic layer | GPSfixedPoint |

Point text | [name]

[name] b |
Insert -p
(I

Offetx pant et
Offset ¥ point - text  |0.667

Selected points: 1 oK v Cancel x

Figure 2.65

Properties of the topographic peint '120°

General Graphics Coordinates  Image

Coordinate X (East) |724505.184 StdDev ¥ |0.008500
Coordinate Y (Morth) |5037080.570 StdDey Y |0.006900
Coordinate Z (Height) |58.599 StdDev 7 |0.012400

[ Fixed coordinates

Origin of the coordinates

Survey Type Station X A z

2018139.PD GPS baseline ) 724505184 5037060, 570 58,599

Create new point from selected origin Properties of the selected origin Fixed coordinates from selected origin

Selected points: 1 OK v Cancel b 4

Figure 2.66
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GPS point properties
Device (5813580201075 | =
Point name | 120 J
Information |.L-]ltCh | E
Latitude |45°2?U3.51681‘N | |gg°pp‘ss.ssss" vl
Longitude | 11°52'15.05733°E |
Elevation |58.599 |
East |724505. 134 |
North |5037080.570 |
Height |58.59 |
Pole height |2.000 Vertical
Phase distance |0.064 |
HRMS |0.009758 |
VRMS |0.012400 |
State |FIXED |
Visible satelites |14 |
Epachs E |
PDOP L6 |
HDOP 0.8 |
VDOP 1.4 |
TDOP 0.0 |
GDOP 0.0 |
Covariance |0.000096,0.000018,0.000076,0.000033,0.000019,0.000
Local time |24/08/2018 |
Start week 2015 |
Start seconds |459827.000 | v
oK v Cancel X
Figure 2.67

By clicking on Table points button in Figure 2.57, you can create a table with a list of all the
points in the project that will be grouped together with their coordinates, names,
descriptions and codes, as shown in Figure 2.68 (an example of a table with 128 points in
memory).

Stonex Cube-link v4.3 — User manual 55



STONEX

You can also print the table with the Print button. This button will open a text file editor
where the table with all the points will be visible, at this stage the table can be modified in
its fields, contents and graphic appearance.

& Table of Topographic points (26 points) O >

Point ¥ [East ¥ fMorth ZHeight Descriptian Code G

! 100 0,000 0,000 0,000

! 101 0.000 13.433 1.434 —

! 102 1.198 1.223 -0.092 ——

! 103 34.145 9.449 0.947 ——

! 104 31.734 0,141 1.554 —

! 105 25,251 -4,950 1.698 —————

! 106 22,157 -7.224 2.338 ——

! 107 18,145 -10,205 0.593 -—

! 108 14,023 -13.208 1.819 —————

! 109 10.978 -15.440 1.859 ——

! 110 6.964 -18.424 0,400 ——

! 111 2,794 -21.472 2.360 —

! 112 -0.688 -24.043 1.445 —————

! 113 4,125 -26.576 2,400 ——

! 114 -£.291 -27.340 1.211 -—

! 115 -3.538 -11.647 0.600 —————

! 116 -9.938 5.937 1.437 ——

! 117 -7.135 -20.678 0,090 -—

! 113 -1.098 -17.143 0.093 —

! 119 0,137 -11.072 0.063 —————

! 120 9.966 -11.332 0,405 ——

! 121 9.416 -3.777 0.052 -—

L BV 14.708 -1.778 0.060 —

a .- < nen narn R e

< >
Print =] Close b4

Figure 2.68

The commands that are grouped together in Various operations command menu, in Figure
2.56 are: Rename points, Text properties, Text offset; their use is rather intuitive and are only
the repetition for the convenience of the user of some functions already present in the
Topographic Point Properties window.
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2.5.2 Manage coordinates

The Manage coordinates section is shown in Figure 2.69, each of these commands opens
pull-down menus with other subcommands. Below the description of all af them.

@ N A

Reference  pototranslation  Coordinates
system 7 conversion ¥

-

Manage coordinates

Figure 2.69

2.5.2.1 Reference system

This command consists of four subcommands, each of which opens a new screen.

Preset reference system (Figure 2.70) allows you to select a reference system and save it as
a default system (the program must always have a set reference system and will
automatically take the user to this window, if no reference system is set). In this screen you
can select the country and and its Projections, among those available. You can also select
the Geoid from the drop-down menu that will show all available ones. Note that it is always
possible to insert a new geoid in the program, thanks to the Upload utility files command
described in par. 2.1.4. Cube-link supports all major geoid formats: GGF Files; UGF Files; GEO
Files; GRD Files.

A Projection can be changed in its values by clicking on the Create New button, so the new
edited projection can be saved (it is saved in the previously selected country, in the
projections’ drop-down menu, in the last position.) To delete it, press Create again, select
the Projection and click delete). By clicking Show parameters, you can view the values of the
chosen Projection.

The local reference system command leads to the screen in Figure 2.71. Setting a local
reference system deletes the predefined reference system. To access the local reference
screen, there must be at least one topographic point in the active project, considered as the
origin point. Normally the program will select the first point of the list as the origin point,
you can always select a new point, among those available on the left at the bottom of the
list of points. On the right side of the screen you can set the Geoid, the Ellipsoid and some
of its values, it can also be set the method of calculation that you intend to use in the
generation of the system.

The Calculation 7 parameters command (Figure 2.72) in available only in the program
Cube-manager.
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Add preset system opens a screen as in Figure 2.73. This window with the relative
functionalities is the same that is generated if you press the Create new button from the

screen relative to the Preset reference system command.

Datum reference system

Select Country - Projection - Datum

Select Country

[World

Select Projection - Datum

|UTI'u1 zone 325 / WGS 84

Select Geoid

|EGG9?_QGRJ.GHD

[] 5et as defautt system for new jobs

E&, Create new 4 Show parameters

Open

oK

Cancel

Figure 2.70
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Local system

Define local system

Qrigin Point

Paint name |18?

East (m) |726708.928

North (m) |5049321.325

Height {m) |73-728

Latitude |045° 33 37.7155°N

Longitude |011° 54 1804987 E

Ellipsoidal h. |?B.?2B

Points list

127
11ad
111
112
113
114
115
1lle
117
11s
115

Geoid

Tl v
Ellipsoid

WES 84 ~

Major axis (m) |63?813?.000 |

Flat [208.25722203 |

Elipsoidal average height {m) 0.000

Calculation method

(®) Rectangular geodetic at zero height
() Rectangular geodetic at height

() Tangent plane - polar projection

(7)) Tangent plane - orthogonal projection

Proceed v Cancel b4

Figure 2.71
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Calculation 7 UTM parameters
Geographic coordinates : Cartesian coordinates ‘—:

Poirt name Latitude Longitude Elevation East Morth Height dEast dMNorth dHeight -
110 45°2703.54645"N | 11°52'15.54893"E |58.572 724454109 5037061.050 58.572
m 45°2703.53657"N | 11°52'15.57696"E | 58.605 724454 725 5037060.789 58.605
112 45°2703.52669"N | 11°52'15.65278"E |58.632 T24456.386 5037060.561 58.632
113 45°2703.52070"N |11°52'15.68388"E |58.642 724457068 5037060.400 58.642
114 45°2703.56138"N |11°52'15.70082"E |58.647 7244573531 5037061.688 58.647
115 45°2703.64362'N |11°52'15.75899"E |58.637 724458 564 5037064.252 58.637
L1118 AR TOANA"N | 11°R2'16 FNIRN"E | AR AT T2AAG7 JE6 ROITOEE 197 RA RRY e
Elementi proiezione [World - UTM zone 325 - WGS 84 | Coleulate false origins ->
Trasformazione | TransversalMercator i |
Latitude origin |D |
Longitude origin |9 | Calculate Helmert -)
False East |5DDDDD |
False Notth |D | Calculate Molodensky -)
Deformation Modulus |D-9995 |
Latitudine Parallelo Sud [o | Create new Datum/Prjoction. =
Latitudine Parallelo Nord [o |
Azimuth |£l | Geographical coordinates file
Angolo Rettifica Griglia |‘:l | | | | . |
Meridiano |Greenm'ch - | | Corfimm geographical points file == |
Seale Factor fppm) |D | () Verto Format O GGA format () sexadesimal (® Sexagesimal
R |D | Cartesian coordinate files
) E | | 1]
Re (") o | —
Ta m) |D | | Confirm Cartesian points file -) |
Ty {m) 0
Tz (m) 0
Blipsoid [was 84 vl Concel X

Figure 2.72
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Projection Datum
Projection elements
Transformation
Latitude origin
Longitude origin

False East

False Morth
Deformation Modulus
Latitude Parallel South
Latitude Parallel Morth
Azimuth

Angle correction grid
Meridian

Meridian Lonaitude

Datum elements
Scale Factor (ppm)

R (™)

Ry (7)

Rz (™)

T (m)

Ty (m)

Tz (m)
Blipsoids
Ellipsoid

Major Axis (m)

Flat

|World - UTM zone 325 - WGS 84 |

|TransversaIMercatnr e |

|45.45ﬂ5555555556 |

| 11.8708333333333 |

Mew country
|724506.5851 | ord |
| 5037141.1757 |
|n.9996 | MNew projection
|New Pajection |
o |
|U | Mew datum
|U | |New Datum |
|U | Add
|Greenmd1 ~ |
b |
| |
| |
| |
| |
| |
| |
| |
(WGS 84 v|
6378137 |
|298.257223563 |
Confirm changes Vv Cancel p 4
Figure 2.73
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2.5.2.2 Rototraslation

In the Rototranslation command (Figure 2.74), there are the functions Translate points and
3D/2D Rototranslation. The second command is available in Cube-manager, M module -
Modeling.

By clicking on the Translate points button you access a window in which a list of fieldbooks
present in the project is displayed (Figure 2.75). The translation can be performed on all
points (default choice, Select all points checked) or on selected filedbooks. It is therefore
possible to set an East translation and/or a North translation and/or a Height translation
with the relative scaling factors. The exchange of coordinates can also be performed (the
first choice, selected by default, does not perform any exchange).

R X

\ ¥ X

Rototranslation  Coordinate
conversiol

o

J- Translate points...

Figure 2.74

Translate points
Select all points

Select the fieldbooks to translate

Fieldbook Type Stations Points ~

n 2018139.FD GPS 1 128

Ll

Ll

] W

Coordinates exchange
(®) %-v-Z (no change)

East translation |m

Morth translation |U-DUD

|
| () rx-z
Height Translation |':'-':":":' | O 2y
Abscissa scale factor | 1.000 | () v-ZX
Ordinate scale factor | 1.000 | )z
Height scale factor | 1.000 | O z-rx
ok - Cancel »

Figure 2.75
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2.5.2.3 Coordinates conversion

The Coordinates Conversion command opens a submenu consisting of three commands:
Stake-out GPS, Stake-out TS and Coordinates Conversion (as in Figure 2.76). The third
command is available in Cube-manager, T module - Topography.

By clicking on Stake-out, you can convert the grid coordinates to GPS geographic
coordinates. After selecting the points (both CAD and topographic) that you want to convert,
the program will switch to the screen as in Figure 2.77. From here you can define from what
survey to calculate the stake-out (mandatory), and from which station (mandatory). The
station may exist, or a new one can be created. Then you can define the options for the new
topographic points (only in case of CAD points) and for the baselines.

@ N A |7

Reference  pptotranslation | coordinates | Editfieldbook
system - conversion - - fi

-

Manage coordinate| Stake-out GPS

ER_DEFAULT - [from Stake-out TS

Coordinates conversion...
—I-..J. R o, T T ﬂl‘:.ldl_.-l. ‘m m L

Figure 2.76
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GP5 stake-out

Survey 2018139.PD w
(®) Existing 187 v
Station
O Mew
Antenna h. 0.00 @APC=

Mew topographic points options (1)

Initial name |

Layer

|
Code |
|

Description

Baseline options

e | | e [ ]
Antenna h. @APC= 0,064

[] replace existing baselines

Cancel variance and covariance matrices

(1) Enabled only in case of selected CAD points

oK v Cancel »

Figure 2.77

By clicking Stake-out TS instead, you can select the points to build a fieldbook from Total
Station. In Figure 2.78 is shown the window for this command, on the left you can select the
station and orientation, from the list on the right you can select the points you want to
include as measures of the inserted station.

In the table below it is possible to view the fieldbook being created, the structure is similar
to that which will be described in the next paragraph relating, to the Totals stations’
fieldbook.
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Once you have completed the insertions of the fieldbook, you can create a text file or enter
the processing screens of the fieldbook (Confirm fieldbook command), where you can
perform all the classic operations available in the program on the fieldbook from total
stations (the functions will be described in detail in the next paragraph).

Stake-out TS

Station selection and orientation

Selection of points to be inserted in the selected station

1000 - 1000 ~
110 110
et
112 112
113 113
114 114
115 115
116 h 116
. 117
(®) Select station () Sselect orientation 118
Station [110 | E_g
Orientation |111 | E
123
Hstation [1.65 | 124
125
H pole |1.s | o
. 127
Azimuth |128.8084 | P
129
130 h
Ficldbook name |job4 | Insert all points v 4 Insert selected points &
) ) Horizontal Vertical ) Horizontal ~
Station H station Mame H paole reading reading 3D distance distance
110 0.000 229 0.000 73.7299 98.9157 31.233 31.278
110 0.000 230 0,000 78.4791 99,3184 47,829 47.827
110 0.000 231 0.000 86.9420 99,5075 65,198 55,196
110 0.000 232 0,000 92,1927 99,5998 83.408 83.406
110 0.000 233 0.000 95.3710 99,6986 101.654 101.653
110 0.000 234 0,000 201,9550 99,6796 10,592 10.591
110 0.000 235 0.000 199,2592 99,5755 10.198 10.198
110 0.000 1000 0,000 62.44a60 98,2210 25.028 25.018
110 0.000 2000 0.000 89.4786 99,5409 72,529 72.327 w
L4 >
Export to text file v Confirm fieldbook " Cancel x

Figure 2.78
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2.5.3 Fieldbook

In this section (Figure 2.79) you can import a fielbook as a file, download it from total stations
or write it manually. The operations that can be performed on the fielbook are the
memorization, calculation and export of the points calculated in the CAD. The program
controls the measurements of horizontal, vertical, direct and inverse readings and performs
the averages. The program also checks for points with the same name measured several
times within the same station and check that the measurements are averaged. Note that the
information displayed, when importing a Total station file does not show the raw files, what
is displayed is the result of a reading and interpretation of the data by the application.

E—TTY [ o |

]

7 B~ Bl T
Edit fieldbook  Import Export Lewveling
-~ fieldbook~ coordinates~ .
Fieldbook
Figure 2.79

2.5.3.1 Edit fieldbook

By clicking on the Edit fieldbook button, you access a submenu as shown in Figure 2.80.

—r = r

2 | B~
Edit Import E:
fieldbook™ fieldbook™ coor

Mew fieldbook (manual)
Dpen existing fieldbook
Create fieldbook from file
Fieldbook from job

Figure 2.80

The available functions are: New fieldbook (manual), Open existing fieldbook, Create
fieldbook from file (with extension from Stonex Total stations), Fieldbook from job.

By clicking on New fieldbook (manual), you can manually write a fieldbook; in the first screen
that follows (Figure 2.81) you can give a name to the fiedlbook (mandatory choice, otherwise
the program will not allow you to proceed), and then enter a series of other information
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related to the latter. All fields are left blank, only the date is set automatically by the system,
but can be changed.

Fieldbook Information

Fieldbook name |Site1 |

Date [422019 1139

Location |Creek-5haniko, Cregon |

Surveyor |Mr Smith |

Device |Sh0nex R25 |

Serial number | —

Description |c0nh’0||ing erosion

Note |

Note |

Note |

Note |

Note |

|
|
|
|
Note | |
|
|
|

Note |

oK -) Cancel b4

Figure 2.81

The next screen clicking OK automatically leads to the first measurement (Figure 2.82), by
default the name of the first station is St1 and is defined as temporary ("Temporary" means
that the coordinates have not been calculated, "Calculated" means that the coordinates have
been calculated in the field and "Known" means it has known coordinates). The height of the
instrument is set to 1.00 m, all other details are left blank and can be entered by the user.
Even the details provided as default settings can be changed. As for the Information label, if
you click on the icon next to it, you can access a function like the one described above (Figure
2.62).

In the section related to the details of the point, the default assigned name is Pn1 and its
coordinates are considered temporary (with the same logic used for the stations). Other
values set by default are the height of the pole, the vertical reading, the temperature and
the pressure, these values can always be changed.

For horizontal readings, vertical readings and distances, the application dynamically
calculates the averages and residuals, returning a correct value also based on the settings of
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the survey elements (right on the screen: prism constant, temperature, pressure, transverse
eccentricity, horizontal eccentricity).

By clicking on the icon with the wrench on the right, you can access the list of parameters
related to the fieldbook (Figure 2.92). Parameters for setting the decimals you want to
display on the screen and the representation of the angles. Furthermore, it is possible to set
a series of tolerances and a series (on the right) of other values, which the system will
consider when calculating the measurements.

At the bottom of the screen (Figure 2.82), it is possible to read the information resulting
from the calculations (considering the set parameters), relative to the horizontal distance
and the height difference, including the difference in height between the height of the
instrument and the height of the prism.

Fieldbook page
Point page
Station name East |U-UUU | (® Temporary
H antenna |1.DDD | Morth |D.DDD | O Caleulated
Information | | E Height |0.000 | O Known ) 4
Point name |Pn1 | Measurement time | | Layer |1 |
Pole height [1.000 |
Information | | E
X ® X
Direct (q) [0.0000 100.0000 Prism constant |0.000
Reverse (g) | | |--- | | Temperature (C%) |ZU.D

Average (g) [0.0000 | [100.0000 |[~

Residue (g) |--- | |--- | |--- Transverse ecc, |D.DDD

|
|
Pressure (mmHg) | 760.0 |
|
|

Correct (g) [0.0000 Horizontal ecc., [0.000

Calculation {g) |0.0000 | |100.0000 | |— (® Temporary O Calculated O Known

Horizontal |0-000

|
|
|
| [100.0000 |[= |
|
|
|
|

East |0.000

Diff, height [0-000 North [0.000 |
Diff, height (+ht-hp) |0-000 Height |0.000 |
Add -) Cancel b 4

Figure 2.82

After entering the information of the new station and the new point, clicking the Add button,
the application will open a new screen (Figure 2.85), where you can view a table with all the
stations created and their points. The lines in the table are yellow or white, alternating each
time the station changes so it will be easy to identify briefly the passage from one station to
another.
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In the table screen you can enter a new station and its first measurement or a new
observation. In the first case the station name will be sequential to the last one inserted and
the point name will be left blank, in the second case the name of the station remains the
same and the name of the point will be sequential to the last one created.

With the right-click on the table, you access a menu of options that, depending on the
selection made (number of cells and position) offers a series of functions (Figure 2.84, some
options seem to be disabled but they are all available, for facilitate the use of the menu some
functions become dynamically active while others are deactivated).

These functions are simple to use, you can insert a new measure between the already
inserted observations (Enter observation), you can add a new observation at the end of the
table (Add observation), you can change the entered numerical values as well as the names
of the points and the selected lines can be deleted.

These operations can be canceled by clicking the icon at the bottom left of the screen (blue
undo icon).

When all the observations have been entered, it is possible to press the End of manual entry
button and the screen will automatically change its appearance (Figure 2.85); you can see

the table and, in at the bottom-left you can select the desired station, to place the visible
part of the table on it.
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Enter observation

Add observation

Exit

Clear selected rows

Change the column value

Renamne collected points

Figure 2.84

| HET iSRRI = | ‘ a"ndNef':“s: tnz':eﬁ::ue - ‘

Station Hstation Mame Hpoint Ir-l:artijzi:;ial :I:argi‘%l Distance Information .

1.000 Pn1 1.000 0.0000 100.0000

1.000 Pn2 1.000 0.0000 100.0000

1.000 Pn3 1.000 0.0000 100.0000

1.000 Pn4 1.000 0.0000 100.0000

1.000 Pns 1.000 0.0000 100.0000

1.000 Pni 1.000 0.0000 100.0000

1.000 Pn7 1.000 0.0000 100.0000

1.000 Pn3 1.000 0.0000 100.0000

1.000 Pn2 1.000 0.0000 100.0000

1.000 Pni0 1.000 0.0000 100.0000

1.000 Pnil 1.000 0.0000 100.0000

1.000 Pnia 1.000 0.0000 100.0000

1.000 Pnib 1.000 0.0000 100.0000

1.000 Pnic 1.000 0.0000 100.0000

1.000 Pnid 1.000 0.0000 100.0000
1.000 Pnie 1.000 0.0000 100.0000 "
End of manual entry - Cancel X

Figure 2.83
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Fieldbook menu

Manual fieldbook composition
Fieldbook ready
Station Hstation Mame Hpaint :g;ﬁ;tal :’:;gﬁgl Distance Information
. 5t1 1.000 Pnl 1.000 0.0000 100.0000
é 5t1 1.000 Pnz 1.000 0.0000 100.0000
é 5t1 1.000 Pn3 1.000 0.0000 100.0000
é 5t1 1.000 Pn4 1.000 0.0000 100.0000
% 5t1 1.000 Pn5 1.000 0.0000 100.0000
é 5t1 1.000 Pn& 1.000 0.0000 100.0000
é 5t1 1.000 Pn7 1.000 0.0000 100.0000
é 5t1 1.000 Pna 1.000 0.0000 100.0000
é 5t1 1.000 Png 1.000 0.0000 100.0000
é 5t1 1.000 Pni0 1.000 0.0000 100.0000
% 5t1 1.000 Pnil 1.000 0.0000 100.0000
é 5t2 1.000 Pnla 1.000 0.0000 100.0000
é 5t2 1.000 Pnib 1.000 0.0000 100.0000
é 5t2 1.000 Pnic 1.000 0.0000 100.0000
é 5t2 1.000 Pri1d 1.000 0.0000 100.0000
é 5t2 1.000 Pnile 1.000 0.0000 100.0000
é 5t2 1.000 Pnif 1.000 0.0000 100.0000
é 5t2 1.000 Pnilg 1.000 0.0000 100.0000
Select station
5t1 ~
OK -) Cancel %
Figure 2.85

In Figure 2.85 the command on the top-left, Fieldbook menu, if clicked will offer a series of
operations possible on the fieldbooks (Figure 2.86). It is mandatory to use one operation to
proceed.

In the Fieldbook menu, the Calculations command consists of four subcommands: Traverse
calculation, Detail calculation, Various calculations, 2D network calculation. The only
calculation available in Cube-link is the detail calculation, the others are available in Cube-
manager, T module — Topography.

To carry out the detail calculation, just click on the relative command that will lead to the
screen in Figure 2.87, on the left is the list of stations present in the job, you can select and
calculate one or more stations by clicking on them, or you can calculate all the stations by
clicking on the Transfer all button.

The list named Stations to be calculated will show the stations that you chose to calculate,
when you click on Proceed, if the system does not find known points, it will generate a screen
(Figure 2.88), where you can select the station and the first orientation (coordinates can be
assigned/changed if necessary). To start the calculation, it is possible to click on Confirm
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calculation (Figure 2.89). Uncalculated stations will be displayed in the list on the right,
named Stations not calculated; help messages will appear below the list (in this example, 'All
stations calculate ', 'All backsights in the expected tolerance’). View report button will show
an html file with the details of the calculation, the Repeat calculation button will perform the
calculation again. On the right there are the differences of East, North, Height between the
maximum and minimum values found in the work, this information can help to find errors.
The X-gray icon will delete from the list of stations to be calculated the one selected, the
trash icon will erase all stations in the list. The icon with the wrench leads to a window like
the one shown in Figure 2.92.

Returning to the commands in Figure 2.86, View all measurements, View averaged
measurements and Calculate averages are other available functions, the first two are display
options, the last, work on the fieldbook, taking all the measures into consideration and
calculating the averages.

This last function (Calculate averages) opens a screen (Figure 2.91) in which it is possible to
set tolerances, text colors, layers, symbols and relative colors (for known points, detail points
and stations), decimals, representation of the angles and corrections (such as atmospheric
refraction), clicking Proceed the program will proceed to the average calculation.

The Load known points command opens a menu with three options: Read from file, Read
from current job, Cancel known points. The first command opens a screen where you can

select a text file containing the coordinates and indicate a separator character (Figure 2.90).

Work parameters will open a window as in Figure 2.91.

Stonex Cube-link v4.3 — User manual 72



©

STONEX

Fieldbook menu
Calculations 3

View all measurements
View averaged measurements

Calculate averages

Load known points »
Work parameters

Enable manual entry

View report

Insert fieldbook in the job
Memorize fieldbook

Print fieldbook

Export in GSI format 3
Export in IDX format

Export to text file

Exit

Figure 2.86

Topographic calculations

Type of operation

Station list =)  Stations to be calculated Not calculated stations

5t1 5t1
5t2 5t2

[ indude UTM corrections

Transfer all -) X

Calculate heights

’
Cancel calculations == h‘ oK -) Cancel x

Figure 2.87
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Start orientation

No known points

Station name |100

[] Assign coordinates to station and orientation

East |0.000

North |0.000

101 -~

102

Height [0.000

|
| Select start orientation
|
| 103

104

Orientation name |110

105
106

East [6.365

107

North |-18.424

109

Height |0-400

|

| 108

|

| 111
112

-

Confirm coordinates  &# 114

113

115
116

Horizontal reading |1?'G-991?

| 117

Start azimuth |176.9918

118
| 119 v

Topographic calculations

Type of operation

Station list -

0K -p Cancel b4

Figure 2.88

Stations to be calculated Mot calculated stations

100

Cancel calculations ==

» 100

All stations calculated
All backsights in the expected tolerance

East diff. min max

View report 44.084

Morth diff, min max

Contem oo +/

Height diff, min max

Repeat calculation ==

[ 1ndude UTM corrections

Transfer al - X Iﬁ]

Calculate heights

x OK -) Cancel *

Figure 2.89
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Impaort file

é Select the points file to import
TXT

Mame and path of points file to be imported:
|C:\Users\ibucd\Dncuments\CubeOﬁ‘lce.ProjedsKnowCow.t:t | | . |

17a,1318598.55317162.5853404.43268186,146 920657
17b,1318598 90199432 5853402 93870001, 146 930333 Setthe separator character
17,1318599.78630822, 5853404 56011961,144.996034

® Comma ()

() Semicolon (;)

() Slash ()

(") Backward slash (4
(") Colon ()

() Tabulation (TAB)

() Space ()

Oore [

[] Intestazione

oK =} Cancel b4

Figure 2.90
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Fieldbook menu

Opzioni e Parametri di calcolo

Make fieldbook Symbols
Record only point coordinates Known point symbol AT” angle e
Station symbol |{_}Circle ~
Detail point symbal +CrOSS ~

Symbol size |2.00

Height tol 0.010
eigl erance Known point color

Font Arial Station color _

Horizontal tolerance (g) |0.0010 Layers
Vertical tolerance (g) |0.0010 Known point layer | RefPoint w
Station layer | Station ~
Distances tolerance |0.010
Detail point layer | point w
Coordinates tolerance |0.010
o |

Textsize |4.00

Font color

I

Advanced parameters ==

oK -p Cancel X

Figure 2.91
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Fieldbook parameters

Fieldbook parameters

Angles representation | Grads (g) w Apply atmospheric refraction correction
Horizontal reading decimals | 0.0000 ~ Coeffident of atmaspheric
Vertical reading dedmals | 0,0000 o Apply temperature and pressure correction
Distances/Height diff. decimals |0.000 - Distances: Earth curvature correction
H.pole/H.prism decimals | 0.000 u (® Calculate dist. on average height (m||j,9 16 |
Eccentricity decimalzs {0,000 i () Calculate distances at sea level
Temperature Pressure dedmals | 0.0 o Height diff.: Earth curvature correction
Coordinate decimals | 0.000 ~ Ellipscid |WGS 84 - |
Height decimals | 0,000 9 Approximate latitude |045° 00' 00,0000 M

Local sphere |6356680,374

Sexagesimal second decmals | 0,00 e

Horizontal tolerance {g) [0.0010
Vertical tolerance (g) |0.0010
Distances tolerance |0.010

Coordinates tolerance [0.010

Modi Cancel
Height tolerance |0.010 Y - x

Figure 2.92

Among the commands shown in Figure 2.86, the Enable manual entry button will lead to the
manual writing section of the fieldbook (described above).

The View report command will open a screen with a html file containing all the information
on the current fieldbook. If the program recognizes that there are several reports present in
the job, a window will open in which all the reports will be displayed so that you can select
the one you want, in this screen you can also delete (one or more) reports.

Insert fieldbook in the job button will insert the fieldbook in the graphics; before proceeding,
the application will check the presence of average measurements and if the calculations have
been performed, then it will be possible to see again a summary of the measurements (any
unaveraged measurements will be visualized on red lines, so that corrections can be made).

With the Memorize fieldbook you can save the fieldbook; after displaying the screen with
general information (e.g. fieldbook name, date, location, etc.), once you have chosen the
destination for saving, the application will produce a file with the .cubefbk extension.

The Print fieldbook command allows access to the general information screen on the
fieldbook (as in Figure 2.81, where you can change all the fields if necessary), when you click
on Proceed the application creates a html file, ready to print.
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The last commands are related to the export, the fieldbooks can be exported in GSI format
(18 and 6 bit), in IDX and in text files (as well as in the native format of the program .cubefbk).

2.5.3.2 Import and export fieldbooks

The Import fielbook button (Figure 2.93) allows to import fieldbooks from total stations; you
can import using a USB connection by connecting directly to the total station (after clicking
on the chosen device, click on the Connect USB button) or selecting a file that may be stored
in the PC. Figure 2.93 shows all supported devices (in Figure 2.94 shows all the extensions
supported).

The Export coordinates button allows you to export to the total station formats and to GSI
(16 bit and 8 bit).

EA Elh = g
Import Export Leveling -\I,
fieldbook™ coordinates™ - ol
B RLPlus/RLS Feld
i@ | R2/R2S Plus
B | RZL Plus/R25
B R2ZW/R35 - FieldGenius (*.raw)
SurvCE [*.rw5)
AntasMobile (*.csv)
Figure 2.93
G5l file (*.gsi)
R2LPlus/R253(*.r25:*.mes)
R2ZLPlus(*.led)

R25Plus/R15(*.r15;*.dat)
FieldGenius RAW (*.RAW)
RWS5 file (*.RW3)
AntasMobile C5V (F.C5V)
CubeH24 (*.cubehl4.csv)

Figure 2.94
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2.5.3.3 Leveling

The Leveling command consists of three subcommands: Download (available for free in
Cube-link); Trigonometric leveling (available in Cube-manager); Geometric leveling
(available in Cube-manager, Figure 2.96). The first opens a screen as in Figure 2.95.

After selecting (at the top) a data destination file and setting the data for the input port, you
can download data from a digital level.

Data download from digital level - m} x

Destination file Serial port properties

Port name: | No ports found ~

Data preview Baud rate: |19200 ~
Data bits: |8 ~
Parity: | None ~
Stop bits: |1 ~
Handshake: |None v
Start download -
Close b 4
Figure 2.95
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Compensazione altimetrica

E:;ﬂezza Purto amivo Diglivello {m) Distanza (km) S:;’t:ne Quota purto |Nome del punto 1 |
0 Mome del punto 2
5 | |
0 Quota punta 1
= |  cogr +|
0 Guota punta 2
O Incogr ~
0 Dislivello
0 | |
Distanza (Km)
= | |
O
O Aggiunge
O
g Cancella
O
O .
Sostituisce:
0 -
[
O
O Fine inserimento
[
O
1
Compone file dislivell Annulla »®
Figure 2.96
2.5.4 Fieldbook schema
Availability Module
Cube-manager (Figure 2.97, Figure 2.98) P-T-M

[] Show

'_EI('_ Cptions...

Fieldbook schema

Figure 2.97
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Fieldbook schema options

GPS fielbook
View links
[] Printable
Between station and point | 21
Palar fieldbook
View links
[] Printable
Between station and station | a1 |
Between station and point | 101 ” I
OK v Cancel b 4
Figure 2.98

2.6 Raster

The advanced functions for working on raster images are available in Cube-manager,
however the commands Import raster and Delete raster are also available in Cube-link. The
formats supported in import are: BMP; GIF; EXIF; JPG; PNG; TIF; TIFF.
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3 Tool and commands

3.1 Tools and commands of the software

Cube-link supports 2D, 3D and fieldbook view. The windows can be used at the same time,
Figure 3.1.

Project

P
3

H
o

i+ i@ TEdmaae DO 2P

- from layer

E 1
[wla [s]s ieldbook |01/ 53 0y I = & = =
W Fieidbook |
# 20 View © Fieldbook == =l ERIENES s =
% 30 View Surveys (1) * mene Latude ~ % Orbit @ Pan [W, Sclect | [FE| [2] @ @ | 30 Views ~
&% Topographic paints [E mierm50 K n e 4
5 187 - 2 A
* 10 = ePs (1) 3w - I g
- = 187 (128) 41 T
B s 1 527 0356190°N R
T & s 14527 1364567 A
Tm 7o 045° 27 03.70808° N +=
- +
114 o 7 e
- 415 9 118 +
e ] e 4 "_'.'%
- 1 120 ase N M + -
w e vase 27 csaaser o= o
T 18 13 12 145° 27 03.43720° N " >
45 e 5
T 118 1 05027 33120°N - B e g
] 15 1 w5027 6329097 N . S S 4=+
T 15 135 1458 27 03.26044° N - . o -o"gm -“4', Fi, "’i.‘
™ 122 17 e 45727 02.26245° N 8 TR e = S
8w a5 27 9325597 B T ® 3
T - £ )
Tm s s 27 30 il el . -
1 e o Tae
0 12 04527 03.0288°N [ A
T a - e -
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o = 13 *&; pa
- 8 14 i
2 %
-5 % 135 + -
- 7 16 -‘#:;JF
- 3 8 13
2 @ E
T 13 30 139 0450 27 02.30065" N +w
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-3 2 W 15727 Q2.05801° N * +
L = 18 45° 27 02.09801°N " j‘t‘"’
. P 45927 02.13045°N
T 18 e 5 x

Figure 3.1

The fieldbook view allows the management of surveys (GNSS and TS) present in the current
project.

By operating on the summary tree (Figure 3.2), it is possible to insert a new survey and/or
new elements to the survey. Depending on the selected node, the program will automatically
propose a GPS or TS insertion. After entering the name (Figure 3.3), the insertion will be
automatic and visible in the grid and in the CAD, if the new element points to an existing
topographic point, it will take its coordinates and characteristics, otherwise it will be created
with default values.

If you want to add a new survey it will be necessary to insert in addition to the name also
what kind of survey it is (Figure 3.4).
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E Surveys (2)
=-fi5] 2018139.PD

Figure 3.2

Mew name — O >

Enter a new name for the TS measure

Figure 3.3
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Mew name - O >
Enter a new name for the survey Type of survey
® GPS
TS
oK v Cancel »
Figure 3.4

By acting on the grid, for the editable columns, you can edit the individual values (Figure
3.5) or modify the values by selecting multiple rows or multiple cells Figure 3.6 (right click
on the selection). In the case of multiple selection of multiple columns, the functions
available are those shown in Figure 3.7. Rename will act on the elements of the selected
rows, Copy will copy the elements and allow you to paste the object only in the fieldbook
grid (even of other instances of Cube-manager, different from the current, without closing
the current). The Copy text allows a copy of the textual value of what has been selected, in
all the applications that support the paste text function. The command Delete, deletes the
selected element or elements.

Name Information Quality HA-Direct HA-Reverse HA-
e Unknown 0.0000
cr6e e Unknown 44728
cr2 e Unknown 229.6125
cge Unknown 297.9929
I Unknown
e Unknown 291.0677
I Unknown 291.0679
T Unknown 291.1278
5 Unknown 291.1344
T e— Unknown 297.2394
r A . Unknown 299.6699
I — Unknown 299,6593
N O, Unknown 301.3201
L Unknown 3013147
S Unknown 303.6713
Figure 3.5
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Name Information Quality HA-Direct HA-Reverse H2
oL e Unknown 0.0000
e e Unknown 44728
P2 e Unknown T —
ce | Unknown Edit value...
1 Unknown Copy Crl+C
2 = Unknown Copytext Ctrl+Shift+C
I Unknown
Cut Ctrl+X
4 | Unknown ~ e
5 | e Unknown sste =y
T Unknown Delete Del
. A Unknown 299,6699
T Unknown 299,593
a Unknown 3n1.3201
o e Unknown 301.3147
i e Unknown 303.6713
1 Unknown 309.8328
172 1lol 200 0207
Figure 3.6

Rename...

Copy Ctrl+C

Copy text  Chrl+5Shift+C

Cut Ctrl+X

Paste Chrl+V

Delete Drel

Figure 3.7

The renaming of a single element will bring up a dialog box, like the one shown in Figure
3.8, at the top, the name change that is being carried out is shown, below it must be selected
the function you want to perform. The Rename the point, will rename all the elements of the
survey and the topographic points from the starting name to the new name (if the name
already exists the function will not be completed).

The second choice, Rename the TS measure (which changes according to the element of the
selected survey), will rename only the element of the selected survey, if you enter an existing
name, the program will ask for confirmation of what you want to do as in Figure 3.9, clicking
YES, the result will be like that obtained with the Rename the point, clickng NO only the
selected element will be renamed and will be connected to the existing name element.
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Rename function from fieldbook view — O >

Rename 15 to 'ptdd’

(® Rename the point

() Rename the TS measure

oK v Cancel b 4

Figure 3.8

Fename X

o Eename everything (measurements and stations) from "CP8 to
CP2

Yes Mo Cancel

Figure 3.9

If you rename a station of a survey from Total station, you will need to manually rename the
measurements you want to connect to the renamed (created) station, the program will
always generate a warning message.

The change of value with multiple selection (Figure 3.6), generates a window as in Figure
3.10, on the left you can choose what type of operation you want to perform and, on the
right, you can enter the value.

Changing the East, North, and Height coordinates of an unknown point leads to its
transformation into a known point.

Stonex Cube-link v4.3 — User manual 86



©

STONEX

Edit value — O x>

Operation type

(® Add up the value

() Multiply the value Enter the value for the operation

() Subtract the value

() set the value

oK, vy Cancel b4

Figure 3.10

List of all commands that can be used by the command line (Figure 3.11) of the program,
the commands are case insensitive:

Command Description

OPEN Opens projects (Cube-link files with extension .cubelnk)

SAVE Saves the project ( with extension .cubelnk for a normal
file, with extension .cubetpl for a template file)

NEW New project

DXFIN Imports dxf/dwg files

ASCIIIN Imports generic ASCII files

SHAPEIN Imports ESRI Shapefiles

RWS5IN Imports RW5 files

CUBEAIN Imports Cube-a files

GEOGISIN Imports GeoGis files

DXFOUT Creates dxf/dwg files

KMLOUT Creates a KML file for Google Earth

MAPWWW Creates a map

PRINT Prints the drawing

CUBEAOUT Creates a Cube-a file

RW50UT Creates a RW5 files

GEOGISOUT Creates a GeoGis files

SHAPEOUT Creates an ESRI Shapefile

COPYNOTES Copies CAD entities to notes

PASTENOTES Pastes the CAD entities from notes

SETTINGS General program settings

QUIT Closes the program
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2DVIEW Enables 2D view
3DVIEW Enables 3D view
ZOOMLI Zoom limits
ZOOMIN Zoom in
Z0OOMOUT Zoom out
ZOOMWI Zoom window
ZOOMPT Zoom on topographic point
DYNPAN Activates dynamic pan
ZOOMMA Enables/disables zoom window
AERIALVIEW Enables/disables the panoramic view
POINT Draws a point at the selected location
LINE Line on2 points
CIRCLE Circle with choice of options
CIRCLECE Center and radius circle
CIRCLE3P 3-point circle
CIRCLE2P 2-point circle
CIRCLETTR Tangent, tangent and radius circle
ARC Enables arc design options
ARC3P Arc on 3 points
ARCCE Arc center, radius, beginning and end
ARCBE Arco beginning, end and radius
POLYLINE Draws polylines
RECTANGLE Draws a rectangle
POLYGON Draws a regular polygon
ELLIPSE Draws an ellipse
TEXT Start command for multiline text insertion
DELETE Deletes CAD entities
MOVE Moves CAD entities
COPY Copies CAD entities
ROTATE Rotates CAD entities
OFFSET Offset of the CAD entity
JOIN Connects to entities
FILLET Connects with arc
EXTEND Extends an entity to the limit
TRIM Trims entities
BREAK Breaks entities
GROUP Groups CAD entities
UNGROUP Ungroups CAD entities
EXPLODE Explodes complex CAD entities
PROPERTIES Modify the properties of CAD entities
COPYPROP Copies properties from a CAD entity
DRAWINGORD Changes view order
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FOREORDER Brings to foreground
BACKORDER Sends to background
INSPTONPOLY Inserts polyline vertex or profile vertex
DELPTONPOLY Deletes a vertex from a polyline or a profile
MERGEPOLY Joins two polylines into a single polyline

POLYINHEIGHT

Sets all the vertices of a polyline to a set height.

LAYER

Opens the layer properties manager window

LAYERFROMENT Activates layer from entity properties
CURRLAYER Moves on current layer the selected entities
ISOLALAYER Isolates the layers of the selected entities
LAYEROFF Turns off the layers of the selected entities
LOCKLAYER Blocks the layers of the selected entities
LAYERONOFF Turns the current layer on or off

ALLLAYERON Enables all layers

UNLOCKLAYERS Unlocks all layers

VIDEOTHICK Displays video thicknesses

SYMBOSNAP Sets the osnap symbol size

ROTAXES Sets the cursor axes rotation

AXESSIZE Sets the cursor axes size

VIDEOSCALE Scales the video display

GRAPHICBGROUND Sets the background color of the graphic window
CURSORINFO Sets dynamic info on the cursor (values from 1 to 7)
ORTHO Enables/disables Ortho

OSNAP Enables/disables osnap

NEWPT Creates a new topographic point

CHARACPT Creates topographic points from CAD entities
PTPROP View (edit) properties of the topographic point
PTTABLE View topographic point table

RENAMEPT Rename topographic point

PTOFFSET Edit point-text offset

R1PLUS Imports a fieldbook from a file with .dat or .r15 extension
R2LPLUS Imports a fieldbook from R2L Plus file / R25
R2/R2SPLUS Imports a fieldbook from R2S Plus file

R2WFG Imports a fieldbook from Fieldgenius file
R2WSC Imports a fieldbook from SurvCe/RWS5 file
R2ZWAM Imports a fieldbook from AntasMobile file
EXPR1PLUS Exports coordinates in R1 Plus file format
EXPR2PLUS Exports coordinates in R2 Plus file format
EXPR2LPLUS Exports coordinates in R2LPlus file format
EXPR2PLUSRAW Exports coordinates in RAW file format
EXPR2PLUSRW5 Exports coordinates in RW5 file format
EXPR2WCSV Exports coordinates in AntasMobile file format
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EXPGSI16 Exports coordinates in GSI 16 bit file format
EXPGSI8 Exports coordinates in GSI 8 bit file format
NEWFIELDBOOK Opens a window where to create a new fieldbook
OPENFIELDBOOK Imports an existing fieldbook
LOADFIELDBOOK Imports a fieldbook in one of the supported formats
FROMFIELDBOOK Reads fieldbook presents in the project
DOWNLOADLEVELING Download data from a digital level
TRANSLATEPTS Opens the window where you can translate points and
exchange coordinates

PTTOGPS Starts the GPS Stakeout function
PRESETSYSTEM Sets predefined reference system
ADDNEWSYSTEM Create new reference system
DELETERASTER Delete raster image
RASTERIN Import raster image

i_j Command: |E §§

Maters | X = 724412.458 ; Y = 5037045.500 ; Z = 0.000 | Elev. 0.00| Ortho S Osnap |

Figure 3.11

Another useful tool other than the command line is the Quick selection (Figure 3.12); in
commands that involve selecting CAD entities or topographic points, with the right-click you
can enter a menu that allows you to access a quick entity selection. Selection is divided into
topographic and CAD entities and takes place through the choice of the respective
properties. From this popup window, you can also quickly access the entity properties
window.
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Confirm selection
Ivert selection

¥  Undo selection

Select all
§  Quick selection

Properties

Figure 3.12

Double clicking on the mouse-wheel will execute a zoom limits.

The project manager panel (Figure 3.13, middle-left part of the main screen), is a tree
structure that contains all the topographic and raster entities present in the project. With
the double-click on the points you can select them as an alternative to graphic selection.

Project

® Q@ |fs| S

== Topographic points ()
..... o204

AutoBase

..... P

..... P

..... P3

..... P4

=-T P5

121

1

1

..... ™ PB
_____ T D7

Figure 3.13

The project manager panel can be switched on or off by pressing the Show/Hide button at
the bottom-left of the main screen (icon in the red circle, Figure 3.14). While the two icons
to the right of the command line have the function to recall the system calculator (the first
from the left) and open a file with the date, time and description of the commands entered
in the current working session (the second).
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Command: || | E §§

Meters | X =-26.145 ;Y =-3.605 ; Z = 0.000 Elev.0.000 Ortha | Polar

Figure 3.14

At the bottom of the screen, you can see the coordinates of the elements in the project,
enable or disable the Osnap mode, the Ortho view and the Polar view. Also thicknesses and
grids can be activated or deactivated.

Activating the Reference grid generates a window as in Figure 3.15. In this screen it is
possible to create the ref grid by defining the type and scale at the top. In the main panel,
the construction values of the parameters can be set (default values are always available), at
the bottom you can set whether to build an external frame and with what characteristics.
The Frame captions command opens a screen as in Figure 3.16 where you can choose the
characteristics of any writes. By pressing the Reference grid button in the main interface, you
can deactivate it (if a ref grid is found in the active job, you can delete or deactivate it, or
create a new one).
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Reference grid — O x
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Figure 3.15
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Reference grid — O *

Write cormers coordinates on frame
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Font size | 3 |
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Back b4

Figure 3.16

By clicking the Tools bar button (Figure 3.17), you can customize the layout and display of
available shortcuts (Figure 3.18, all the entries for the available shortcuts. To reposition them
on the screen, click on the 5 left-side dots, to drag and drop the commands).

Object Snap
CAD Drawing
CAD Modify
Measures
Views

Layer

Zoom

Main

Project manager
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Topographic points

Figure 3.17
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Figure 3.18
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